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Welcome to iPhoto

 

This document helps familiarize you with how to use the 
basic features of iPhoto, and tells you about the new 
features in iPhoto 6.

 

You can use iPhoto to easily import photos from your digital camera, organize them for 
fast retrieval, and then share them with family and friends. Whether you have 100 or 
100,000 digital photos, iPhoto keeps track of them all, automatically organizing them so 
you can find them quickly. 

iPhoto puts you in charge of your photographs—helping you import them; organize 
them in albums, slideshows, and books; enhance their appearance; and share them as 
prints, via email, over the web, and in stunning, professionally printed books, calendars, 
and cards.

 

Using This Document

 

This document is organized into three chapters, making it easy access to the 
information you need:
Â

 

Chapter 1, “Welcome to iPhoto”:

 

  

 

Gives a brief description of the major new features 
in this version of iPhoto.

Â

 

Chapter 2, “iPhoto Tutorial”:  

 

Shows you how to import, organize, and view your 
photos, as well as how to create a slideshow and a book.

Â

 

Chapter 3, “iPhoto at a Glance”:

 

  Shows you the different views and controls in the 
iPhoto window.
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What’s New in iPhoto
Â

 

Increased Performance and More Photos:

 

  From scrolling and paging to importing 
and editing, iPhoto is faster and more responsive than ever. You'll even notice the 
boost in speed when opening and quitting the application. And with 250,000 photos 
now supported, you have plenty of room to grow.

Â

 

Full-Screen View:

 

  Take advantage of every pixel your monitor can muster to view 
and show off your photos from one edge of your computer screen to the other. The 
large, high-resolution view makes editing easier and more precise. You can also view 
two or more photos at once, so you can compare or edit them side by side.

Â

 

Cool Calendars:

 

  Get a daily reminder of your favorite photos with the new wall 
calendars in iPhoto. Include up to 24 months of Apple's great designs and import 
your iCal calendar information. You can also add photos or text to any date to mark 
personal reminders and highlight special days, such as birthdays and anniversaries. 

Â

 

Personal Greeting Cards:

 

  Send your very best photos to friends and family with 
4 x 6 double-sided or 5 x 7 folded greeting cards. Choose from themes such as 
birthdays, invitations, postcards, or blank cards, add your own message, and have a 
set sent straight to your door.

Â

 

Photocast Publishing:

 

  Friends and family who use iPhoto can now see your 
photos—and print them out or use them in slideshows, books, calendars, and 
cards—simply by subscribing to your Photocast albums. Subscribers can also use 
standard RSS to access these published albums. As you add photos to them, your 
subscribers see them too, whether they're next door or overseas. 

Â

 

More One-Click Editing Effects:

 

  iPhoto has a click fix for every photo—now you can 
boost colors in a washed-out image, tone them down in a too-bright one, or use 
special effects such as blurred edges or vignetting. 

Â

 

Faster Photo Finding:

 

  Browsing to find one photo among thousands is even simpler 
with the new Scroll Guide—just scroll up and down through the iPhoto window to 
see dates or film roll titles appear over the photos as they move through the viewing 
area.

Â

 

More Flexible Web Publishing:

 

  iPhoto integrates iWeb, Apple's new full-scale 
publishing application, to give you more flexibility to present your photos the way 
you want to. From resizing and editing photos to choosing the right complementary 
theme, it's easier than ever to put your photo albums on the web.

Â

 

Books as Slideshows:  

 

Turn your photos into a customized iPhoto book and share it 
as a creative slideshow. Choose from a range of book themes, add your pictures, then 
view the sequence and edit it as a slideshow to share with friends and family. 

Â

 

Enhanced Printing:

 

  Now it's even easier to print borderless photos. You can also add 
titles to the contact sheets of your film rolls for more efficient organization and 
retrieval.
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Â

 

Enhanced Searching:

 

  Digital photos are imported with a host of information that 
iPhoto now allows you to search. When you create Smart Albums in iPhoto, you can 
search for your photos by details such as the shutter speed or aperture you used to 
take it, the film ISO, and the camera model.

Â

 

Color Profiles:

 

  As your photos are imported, iPhoto assigns them a ColorSync color 
profile that improves the quality of everything you create, from slideshows to books 
to web galleries. You can also choose whether to use these color profiles.

Â

 

More RAW options:

 

  iPhoto offers increased RAW image quality and is compatible 
with even more RAW-format cameras, including the most popular models. 

Â

 

Advanced Organization:

 

  If you already have an extensive photo file structure saved 
on your computer, the new import option lets you choose to have iPhoto point to 
your original photo files instead of duplicating them in iPhoto.

 

Finding Out More

 

For complete and up-to-date information on iPhoto, including tips, news about new 
features, and a list of compatible cameras, go to the iPhoto website at www.apple.com/
ilife/iphoto.

To get help while you’re using iPhoto, look in iPhoto Help, which is available in the Help 
menu when iPhoto is open. You’ll find more information about the topics covered in 
this document, as well as information and instructions for many more topics. 
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iPhoto Tutorial 

 

This tutorial takes you step-by-step through importing your 
photos from a digital camera into iPhoto, organizing and 
viewing your photos, and creating a slideshow and a book.

What You’ll Learn

 

If you follow all the steps in this tutorial, you will be able to:
Â

 

Connect your camera to the computer 
Â

 

Import your photos into iPhoto from the camera 
Â

 

Sort your photos in several different ways
Â

 

Use or add keywords to find and organize your photos
Â

 

Group your photos into one or more photo albums
Â

 

Create and play a slideshow
Â

 

Create a book

As you go through the tutorial, look for the “Did You Know?” boxes that point out more 
things you can do, as well as how to find more information in iPhoto Help.

 

Before You Begin

 

To make it easier to do the tasks in this tutorial, print the document before you start.

In many tasks shown in this tutorial and in iPhoto Help, you need to choose menu 
commands, which look like this:

Choose File > New Album.

The first term after 

 

Choose

 

 is the name of a menu in the iPhoto menu bar. The next 
term (or terms) are the items you choose from that menu.
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What You Need

 

To complete all the parts of this tutorial, you need:
Â

 

A digital camera compatible with iPhoto (for a list of cameras that are compatible 
with iPhoto, visit the iPhoto website)

Â

 

Photos saved in your digital camera
Â

 

A computer with Mac OS X and iPhoto installed
Â

 

Built-in Universal Serial Bus (USB) ports on both camera and computer
Â

 

An A-to-B USB cable

 

Importing Photos From a Digital Camera

 

To edit and share your photos, you must first transfer them into your computer. This 
process, known as “importing,” copies the photo files from their original source into 
iPhoto, where you can then work with them in a variety of ways. 

The most common method of importing is to connect a digital camera to a computer 
that has iPhoto installed.

 

To connect your camera to the computer: 
1

 

Open the iPhoto application on your computer.

 

2

 

Turn off your camera and plug the B connector on your USB cable into the USB port on 
your camera.

 

3

 

Plug the A connector on the USB cable into the USB port on your computer.

 

4

 

Turn on your camera.

Your camera should appear in the iPhoto Source list, located in the top left of the 
iPhoto window.

B connector

A connector
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If nothing happens when you connect your camera, check your camera to see if it's 
turned on and set to the correct mode for importing photos. For information on which 
mode to choose, see the instructions provided with your camera.

 

To import your photos from a digital camera:
1

 

Type a film roll name (for example, “Zoe’s Wedding roll #4”) in the Roll Name field (A, 
shown below) for the group of photos you're importing. (This allows you to search for 
the photos associated with that film roll later.)

 

2

 

Type a description (for example, “Pictures from Zoe’s reception”) in the Description field 
(B, shown below) for the group of photos.

 

3 If you want to delete photos from your camera as soon as they are imported, select the 
"Delete items from camera after importing" checkbox.

4 Click the Import button. (To cancel photo transfer at any time during your import, click 
Stop Import.)

Be sure to wait until all photos have been transferred into iPhoto (or click Stop Import) 
before disconnecting your camera. If your camera has a "sleep" mode, make sure it is 
disabled or set to a time increment long enough to allow your images to download. For 
more information, see the instructions that came with your camera.

To view your pictures, click Last Roll (in the Source list) or click Library and view your 
photos by film roll. To do this, choose View > Film Rolls.

To disconnect the camera from the computer:
1 Click the Eject button in the Source list, or drag the camera's icon to the iPhoto Trash. 

2 Turn off the camera.

3 Disconnect the camera from your computer.

A

B
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You are now ready to view and organize your photos. To learn how, go to the next 
section of this tutorial.

Organizing and Viewing Your Photos 
In iPhoto, all photos are stored within the iPhoto library. You can see the photos in the 
Library by clicking Library, located at the top of the Source list on the left side of the 
iPhoto window. 

Within the library, photos are grouped by year and film roll (either an actual film roll, 
such as 35 mm film stored on a photo CD, or each group of photos you imported from 
a digital camera). 

In this section, you will learn how to sort your photos in several ways, add keywords 
and view photos by keyword, and create a photo album. 

Did You Know?—Importing Photos Without Using a Camera
There are several ways to import photos into iPhoto besides using a digital camera. (If 
you are not using a digital camera, try to ensure that all photos are in JPEG format for 
best results.) You can import photos that are:
Â Saved on a CD (When you take your 35 mm film to be developed, ask if the photo 

developer can store your photos on a CD or floppy disk. Many offer this service.)
Â Saved on a DVD or flash drive
Â Located in a file or folder on your hard disk
Â Saved on a memory card (For a list of compatible storage devices, visit the iPhoto 

website.)

For more information, refer to the “Importing Photos” section of iPhoto Help.
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Sorting Your Photos
iPhoto displays your photos in the order in which you imported them. You can 
rearrange photos in the photo library by sorting them in a variety of ways.

To sort, choose View > Sort Photos, and then choose an option from the submenu:
Â "by Film Roll" arranges photos in the order they were imported. Film roll markers 

indicate photos that were imported together. You can arrange photos by film roll 
only in your photo library. 

Â "by Date" arranges photos by the date on which they were taken.
Â "by Keyword" arranges photos alphabetically by any keywords you’ve assigned to 

them (see “Using Keywords,” next).
Â "by Title" arranges photos alphabetically by their titles.
Â "by Rating" arranges photos from highest to lowest rating. (You can rate your photos 

to mark your favorites. See “Did You Know?—Rating Photos” on page 12.)

To quickly display only your most recent film rolls, click the Last Rolls icon in the Source 
list; to display only your most recent photos, click the Last Months icon. 

Using Keywords
Keywords are labels you can add to your photos, such as “Birthday” or “Sports,” so you 
can easily find all the photos in a specific category. 

iPhoto comes with some basic keywords; you can assign these to your photos or create 
your own keywords by editing the Keywords list in iPhoto Preferences. Once you add a 
keyword to the Keywords list, you can assign it to any photo you choose.

To assign keywords to your photos:
m Click the Keywords button in the bottom-left corner of the window and drag a photo 

from the iPhoto viewing area to a keyword in the Keywords pane.

Or you can do the following:

1 Select the photo or photos you want to keyword.

2 Choose Photos > Get Info.

3 Click the Keywords button at the top of the Photo Info window.

Keywords button
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4 Select the checkbox for the keyword or keywords you want to assign to the photo.

Selecting the checkmark button adds a checkmark to the lower-right corner of a 
photo's thumbnail. A checkmark can be used similarly to a keyword.

To add your own keywords to the Keywords list:
1 Choose iPhoto > Preferences.

2 Click the Keywords button at the top of the window.

3 Click Add (the button looks like a plus sign).

4 Type your new keyword.

You can also rename and delete keywords in the Keywords list. 

Important:  Editing a keyword in iPhoto Preferences changes that keyword in any 
photos to which you've assigned it.

To remove a keyword from a photo, select the photo, choose Photos > Get Info, click 
the Keywords button at the top of the Photo Info window, and deselect the keywords 
you want removed. You can also remove a keyword by pressing the Option key and 
dragging the photo onto the keyword in the Keywords pane (in the bottom-left corner 
of the iPhoto window).

Organizing Your Photos
You can group your photos into albums to better organize your photo library, put 
together the photos you want to burn to CD or DVD, or choose the pictures you want 
to publish on a webpage. 

When you use albums as part of your filing system, you can keep them up-to-date by 
adding new photos. In addition, you can use albums as temporary holding places for a 
group of photos until you’re ready to create something else from the photos, like a 
slideshow, book, calendar, or greeting card. Photos added to or removed from albums 
do not affect the photos in your photo library.

Did You Know?—Rating Photos
You can assign a rating to a photo to indicate how much you like it. These photo 
ratings can also make it easier to sort photos or find them later.

To rate photos:
1 Select the photo or photos you want to rank.

2 Choose Photos > My Rating, and then choose the number of stars you want to 
assign from the submenu.
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To create a photo album:
1 Choose File > New Album. 

You can also click the Add button near the bottom-left corner of the iPhoto window 
and choose Album from the pop-up menu. 

2 Type a name for your album and click Create.

3 Click Library.

4 Drag photos from the library to your new album in the Source list.

You can also drag a photo to an album directly from another album, a CD or DVD, or 
from another location on your hard disk. 

When you add a photo to an album from another location on your hard disk, iPhoto 
automatically imports it into your photo library.

You can also create Smart Albums that can be automatically updated as your library 
changes. To learn more about creating a Smart Album, see the topics in iPhoto Help.

Now that you’re comfortable moving around in iPhoto, you’re ready to create your first 
slideshow of favorite photos. To learn how, go to the next section.

Creating a Slideshow
In a slideshow, a group of photos appear one at a time, in succession. You can use any 
number of photos in a slideshow and place them in any order you choose. When you 
save a slideshow, it appears in your Source list alongside your photo albums and film 
rolls.

Add button

Did You Know?—Making an Album From a Folder of Photos
You can also create an album by dragging a folder of photos from the Finder into the 
Source list, in the top-left corner of your iPhoto window. iPhoto creates an album 
with the folder's name and imports all the photos in the folder into your photo 
library.
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To create a slideshow:
1 Select the photos you want in your slideshow by using one of the following methods:

Â To use an entire film roll or album, click it in the Source list (in the top-left corner of 
the iPhoto window).

Â To pick and choose among the photos in an album or your library, open the album 
or library and hold down the Command key as you click each photo you want.

2 Click the Slideshow button in the toolbar. 

3 Drag the slideshow photos into the order you want in the photo browser at the top of 
the iPhoto window. 

After you create a slideshow, you can add background music, specify the display 
duration for each slide, choose what the transitions between slides looks like, display 
slideshow controls, and set other options. 

Photo browser

Did You Know?—Another Way to See Photos as a Slideshow
You can view any combination of photo albums or individual photos as a temporary 
slideshow. Simply select the photos or albums you want, then click the Play button at 
the far right of the window. If you don't see the Play button, click the right-pointing 
arrows and choose Play from the menu that appears. 
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Setting Slideshow Options
Before playing a slideshow, you can specify the display duration for each slide, choose 
transition effects, and add background music.

To specify the display duration:
1 Select your slideshow in the Source list. The iPhoto window changes to slideshow view.

2 Click the Settings button (in the bottom-right corner of the iPhoto window). 

3 In the Settings dialog, click the arrows next to “seconds” to specify the number of 
seconds you want each photo to stay on the screen. 

To choose transition effects, do one of the following:
Â Choose a transition from the Transition pop-up menu at the bottom of the iPhoto 

window.
Â Click the Adjust button (bottom-right corner of the window). In the Adjust This Slide 

window, choose a transition from the Transition pop-up menu and specify the 
transition duration using the Speed slider. 

Â Click the Settings button (bottom-right corner of the window), choose a transition 
from the Transition pop-up menu, and specify the transition duration using the 
Speed slider. (You can also set other options for the entire slideshow in this dialog, 
including the size of the photos, the Ken Burns Effect, and whether the slideshow 
repeats automatically.)

The default transition for a new slideshow is the Dissolve transition. You can choose to 
have photos appear as if they are on different sides of a cube, have one fade through 
black to the next, and so on.

You can also add background music to your slideshow from the Sample Music folder or 
your iTunes library:

Transition pop-up 
menu

Speed slider
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To add background music to your slideshow:
1 Select your slideshow in the Source list. The iPhoto window changes to slideshow view.

2 Click the Music button in the bottom-right corner of the iPhoto window. 

3 Select a song or a playlist to play during your slideshow. You can search for a song by 
typing the artist or title in the search field.

4 Click OK.

Playing a Slideshow
After you create a slideshow, you can play it on your computer screen. The slideshow 
will fill your entire screen while it plays. 

To play a slideshow:
1 Select the slideshow you want to play in the Source list.

2 To start the slideshow, click the Play button (at the bottom-left corner of the window). 

To stop the slideshow, click anywhere on the screen. To pause or resume playing a 
slideshow, press the Space bar.

While viewing your slideshow, you can:
Â Use the Up and Down Arrow keys to adjust the speed of your slideshow.
Â Use the Right and Left Arrow keys to move through a slideshow manually.
Â Press Delete to remove the photo currently being displayed from the slideshow.
Â Press Command-R to rotate the photo currently being displayed.

You have completed your first slideshow. To learn how to create a book of your favorite 
photos, go to the next section.

Did You Know?—Adding Photos to a Slideshow
After you create a slideshow, you can add photos to it by dragging them directly from 
an album, a CD, DVD, or flash drive, or from another location on your hard disk. When 
you add a photo to a slideshow from another location on your hard disk, iPhoto 
automatically imports it into your photo library.
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Creating a Book
It’s easier to create a book in iPhoto than it is to get all your photos printed and paste 
them up in a scrapbook. Once you’ve created your masterpiece, you have a variety of 
options to share it: You can play it as a slideshow, print it on a color printer, or order it 
as a bound book.

In this section, you’ll learn how to create a book, including choosing the size and 
theme, as well as how to make some basic changes, such as adding photos or moving 
them around. 

To create a book:
1 Select the photos you want in your book using one of the following methods. 

Â To use an entire film roll or album, click it in the Source list (in the top-left corner of 
the iPhoto window).

Â To pick and choose among the photos in an album or your library, open the album 
or library and hold down the Command key as you click each photo you want.

2 Choose File > New Book.

3 Choose a hardcover or softcover book size from the Page Type pop-up menu.

4 Select a theme for your book from the scrolling themes list.

When you select a book theme, you can see an example of it to the right of the themes 
list. (For detailed descriptions and prices, click the Options + Prices button to go to the 
iPhoto website.)

If you chose a hardcover book and want photos to be printed on only one side of your 
book pages, deselect the "Double-sided pages" checkbox.

5 Click Choose Theme. (iPhoto switches to book view. Your new book appears in the 
Source list, and the photos you selected are shown above in the photo browser as 
thumbnails.)

6 Drag photos from the photo browser onto your book pages. If you have more photos 
than you need to fill up all your book pages, you can just leave the extras in the photo 
browser. If you need more photos, see “Making Changes to Your Book” on page 18.

7 If you want, type a new name for your book in the Source list.

Did You Know?—Letting iPhoto Design Your Book for You
If you want iPhoto to automatically design your book by placing all the photos you 
selected on the book pages in the order they appear in your library or album, click 
the Autoflow button.
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Making Changes to Your Book
You can try out a different theme for your book, add photos, rearrange them, and edit 
text in your book. To find out how to make even more changes than those described 
here, see iPhoto Help.

To change the theme of your book:
1 Select the book whose theme you want to change.

2 Click the Themes button. 

3 Choose a hardcover or softcover book size from the Page Type pop-up menu.

4 Select a theme for your book from the scrolling themes list.

If you chose a hardcover book and want photos to be printed on only one side of your 
book pages, deselect the "Double-sided pages" checkbox.

5 Click Choose Theme.

Important:  It's a good idea to decide on a theme before adding text to a book layout. If 
you add custom text to a book layout and then choose a different theme, you may lose 
your text. 

To add photos to your book:
1 Select your library or an album in your Source list. 

2 Drag photos from the library or album to your book (in the Source list).

3 Select your book in the Source list. iPhoto switches to book view.

Did You Know?—Viewing a Book as a Slideshow
You can use an iPhoto book as the base for a more creative slideshow. Choose from a 
range of book themes, add your pictures and text, then view the sequence and edit it 
as a slideshow, including adjusting transitions and adding background music, to 
share with friends and family.
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4 Click the Unplaced Photos button to view the photos you added. This is a holding area, 
like a waiting room, for the photos you want to place in your book. 

5 Do one or more of the following to place photos in your book:

Â To add a photo to an empty photo frame in your book, drag the photo from the 
unplaced photos area to the empty frame.

Â To replace a photo in your book with a new photo, drag the new photo from the 
unplaced photos area to the photo in the book. The new photo replaces the old 
photo, and the old photo is moved to the unplaced photos area.

Â To add a photo to a page, change the number of photos allowed on that page using 
the Page Type pop-up menu, then drag photos to the new empty frames. 

Â To add all unplaced photos to the book, automatically adding pages as needed, click 
the Autoflow button. 

You can change the order of photos on an individual page or from one page to 
another.

To rearrange photos in your book:
1 Click the Page View button to display book pages in the photo browser. 

2 Do one of the following:

Unplaced Photos button

Page View button
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Â To swap photos that appear on the same page, select the page in the photo browser, 
and then drag one of the photos you want to swap onto the other photo.

Â To swap photos that appear in the same page-spread, click the Two-Page View 
button, select the page spread in the photo browser, and then drag one of the 
photos you want to swap onto the other photo. 

Â To move a photo from one page to another, select the page on which the photo 
appears in the photo browser, and then drag the photo from the viewing area onto a 
new page in the photo browser.

Most book themes include pages that contain text you can edit. If you don't see any 
text on a page and you want to add some, you need to choose a design for your page 
that includes text. For more information, see "Changing the design of individual pages 
in a book" in iPhoto Help.

To edit text in your book:
1 Click the Page View button to display book pages in the photo browser. 

2 Select the page that contains text you want to edit.

3 In the viewing area, click the text you want to edit, and then add or edit text.

Important:  When you need to edit text, it's a good idea to zoom in on the text area 
first. To do so, drag the size slider. 

Next Steps
With the successful creation of a book, you have now completed the full iPhoto 
tutorial. If you would like to order a copy of your book, see the instructions in the 
“Sharing Photos in Print” section of iPhoto Help.

For help in using iPhoto beyond the scope of this document, review the topics in 
iPhoto Help, which is available in the Help menu when iPhoto is open. 

Two-Page View button

Size slider
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3 iPhoto at a Glance

As you work in iPhoto, you can see your photos displayed 
in different ways in the iPhoto window; this makes it 
easier to organize your library, edit photos, create 
slideshows, and design your own books, calendars, and 
cards.

The pages that follow introduce you to the different views and controls in the iPhoto 
window. Take a look at these pages to familiarize yourself with the iPhoto controls so 
you can easily follow the instructions in iPhoto Help.
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The iPhoto Window

A Source list:  The Source list includes your library, where all imported photos and video clips 
appear. The Source list also includes folders, albums, slideshows, books, calendars, and cards you 
create to organize and display your photos.

B Viewing area:  View the photos in your library, albums, slideshows, and books. The iPhoto 
window switches between organize, edit, slideshow, and book view, depending on whether 
you’re viewing photos in your library and albums, editing photos, or creating a slideshow, book, 
calendar, or card.

C The Information/Calendar/Keywords pane:  Use this pane to store and retrieve important photo 
information, quickly find photos by date, or find any photo by searching for one or more of its 
keywords.

D Toolbar:  Use buttons and controls in the toolbar to organize, edit, review, and share your 
photos. The controls you see in the toolbar depend on whether you’re viewing photos in your 
library and albums, editing photos, or creating a slideshow, book, calendar, or card.

A

C

B

D
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The Source List
The Source list is where you can easily organize and access your photos.

A Library:  Select to see all your imported photos and video clips.

B Specific years:  Select to see only photos from a specific year. When you import photos, iPhoto 
automatically organizes them by year.

C Recent rolls:  Select to see the last roll or rolls of photos you imported. You can set the number 
of recent rolls you want displayed in iPhoto Preferences.

D Recent months:  Select to see the photos you imported within the last 12 months. You can set 
the number of recent months you want displayed in iPhoto Preferences.

E Folder:  Create folders to better organize your albums, slideshows, and books.

F Album:  Create albums to group and arrange photos by an event, such as a birthday, or a 
particular subject matter, such as nature photos. You can also use albums to organize photos for 
a QuickTime movie or webpage.

G Shared photos:  View photos being shared by other iPhoto users on your local network.

D

F

J

K

H

A

B

G

L

M

N

C

E
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H Smart Album:  Create albums that contain only certain types of photos based on the criteria you 
choose. For example, you can create an album that contains only your highest rated photos 
taken within the last two months. Any photos that match the criteria you choose are 
automatically added to the Smart Album.

I Photocast album:  Allow subscribers to see your published photo albums.

J Calendar:  Create a calendar of your favorite photos. You can choose the number of months, 
note special days like anniversaries and birthdays, and import dates from your iCal calendar. 
Have your calendar professionally printed and give it to friends and family.

K Cards:  Create greeting cards for any occasion using your own photos. Write a personal message 
and order sets of your cards to be delivered right to your door. 

L Book:  Create books of your photos. You can choose different designs (or themes) for a book, add 
text, and even customize the look of individual pages. iPhoto makes it easy to order 
professionally printed and bound copies of your books to share with friends and family.

M Slideshow:  Create a slideshow of your photos to display on your computer screen. You can 
specify the display duration for each slide, choose transition effects, add background music, and 
more.

N Trash:  Drag photos, folders, albums, slideshows, or books that you no longer need to the Trash.
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Organize View
When you select your library or an album in the Source list, you can see all the photos 
contained in the item you selected and use controls for sharing your pictures with 
friends and family.

A Viewing area:  See thumbnails of the photos in your library and albums.

B Scroll Guide: Shows the date and name (if added) of the film roll displayed.

C Rotate button:  Click to rotate selected photos by 90-degree increments.

D Edit button:  Click to display selected photos in edit view.

E Book button:  Click to create a book of selected photos.

F Calendar button:  Click to create a calendar of selected photos.

G Card button:  Click to create a card of selected photos.

H Slideshow button:  Click to create a slideshow of selected photos.

I Email button:  Click to send selected photos as email attachments.

J Desktop button:  Click to make selected photos your desktop images.

K Order Prints button:  Click to order professional-quality prints of your photos. The Order Prints 
service in iPhoto makes it easy to choose a print size and quantity for each of your photos and 
specify a delivery address (available in some countries only).

L iWeb button: Publish photos on a website or photoblog.

M Photocast button: Publish your albums so that other users can subscribe to them.

N Play button: Play selected photos as a temporary slideshow.

O Search field:  Type text to find photos by roll, title, comment, keyword, or filename.

A

C

B

D E F G H JI K L M N

P Q

O



26 Chapter 3    iPhoto at a Glance 

 

Information Pane
Use the Information pane to store and retrieve important information about individual 
photos, albums, books, and folders. The pane below shows the information you’ll see 
when you have a photo selected.

 

P Full Screen button:  Click to view the selected photo using your entire screen.

Q Size slider:  Drag to change the display size of photos in the iPhoto window.

A Title:  A photo’s title is the filename assigned by your camera. You can click the title to change it.

B Date and Time:  Click the date or time to edit it.

C Rating:  Click a dot or star to indicate how much you like a photo.

D Format and Size:  The file format and size of your photo cannot be changed in the Information 
pane.

E Comments:  Click the comments field to add description, narratives, quotations, poetry, or other 
text to your photos.

F Information button:  Click to show or hide the Information pane.
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Calendar Pane
You can use the Calendar pane to quickly search for any photo by the year, month, 
week, or day it was taken.

Keywords Pane
Keywords are labels you can add to your photos so you can easily find them. Use the 
Keywords pane to quickly search for any photo by one or more of its keywords.

A Up arrow:  Click to display the preceding month or year.

B Down arrow:  Click to display the following month or year.

C View arrow:  Click to switch between year and month view.

D Reset button:  Click after you’ve finished a search to display all photos again.

E Months:  Click to show only photos from the months you select. Double-click a month to select a 
specific week or day. If a month is not bold, it does not contain any photos.

F Calendar button:  Click to show or hide the Calendar pane.
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Import View
When you connect your digital camera to your computer using a USB cable, your 
camera appears automatically in the iPhoto window.

C Reset button:  Click after you’ve finished a search to display all photos again.

D Keyword buttons:  Click one or more buttons to display photos that contain those keywords. To 
add a keyword to a photo, drag the photo onto a keyword button.

E Keywords button:  Click this button to show or hide the Keywords pane.

A Date range:  See the dates when the first and last photos on your camera were taken.

B Roll Name:  Type a name for the group of photos you’re transferring from your camera into 
iPhoto.

C Description:  Add a description for the group of photos you’re importing.

D “Delete items” checkbox:  Select to delete photos from your camera as soon as they are 
imported.

E Import button:  Click to transfer photos from your camera to the iPhoto library.
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Edit View
If your library, an album, or an individual photo is selected in organize view, you can 
click the Edit button to switch to edit view. Edit view gives you all the tools you need to 
improve the color and composition of your photos.

A Photo browser:  Click the photo you want to edit.

B Viewing area:  View the photo whose color or composition you want to change. Drag to select a 
portion of the photo for cropping or red-eye reduction.

C Rotate button:  Click to rotate photos by 90-degree increments.

D Constrain pop-up menu:  Choose a size ratio to constrain your crop or red-eye reduction 
selection to a specific dimension.

E Crop button:  Click to edit a photo by keeping only the portion you like and removing the rest.

F Enhance button:  Click to automatically adjust the color and contrast of a photo.

G Red-Eye button:  Click to reduce the appearance of “red-eye” (when a person’s eyes look red in 
your photo).

H Retouch button:  Click the Retouch button and then drag the crosshair pointer in short strokes 
over blemishes and other small marks you want to remove from the photo.

I Effects button:  Click to display effects you can use on your photo. 

J Adjust button:  Click to display advanced editing tools.

K Adjust window:  Use advanced editing tools to adjust a photo’s brightness, saturation, 
sharpness, and more.

L Done button:  Click to leave edit view.

M Arrow buttons:  Click to go to the previous or next photo.
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Full-Screen View
If your library, an album, or an individual photo is selected in organize view, you can 
click the Full Screen button to switch to full-screen view. This allows you to view and 
edit your photo using your entire screen.

A Photo browser:  Click the photo you want to edit.

B Viewing area:  View the photo whose color or composition you want to change. Drag to select a 
portion of the photo for cropping or red-eye reduction.

C Compare button:  Click to compare two or more photos side-by-side.

D Info button:  Click to see photo information, such as title, date/time taken, comments, or rating.

E Rotate button:  Click to rotate photos by 90-degree increments.

F Constrain pop-up menu:  Choose a size ratio to constrain your crop or red-eye reduction 
selection to a specific dimension.

G Crop button:  Click to edit a photo by keeping only the portion you like and removing the rest.

H Enhance button:  Click to automatically adjust the color and contrast of a photo.

I Red-Eye button:  Click to reduce the appearance of “red-eye” (when a person’s eyes look red in 
your photo).

J Retouch button:  Click the Retouch button and then drag the crosshair pointer in short strokes 
over blemishes and other small marks you want to remove from the photo.

K Effects button:  Click to display effects you can use on your photo. 

L Adjust button:  Click to display advanced editing tools.

M Zoom slider:  Drag to zoom in or out on the image.
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Slideshow View
You can create a slideshow from any album or group of photos in your library. When 
you select a slideshow in the Source list, iPhoto displays all the photos in the selected 
slideshow and provides controls for setting transition effects, specifying the display 
duration for each slide, adding background music, and more.

N Arrow buttons:  Click to go to the previous or next photo.

O Exit Full Screen button:  Click to leave full-screen view.

A Photo browser:  Drag photos into the order you want them to appear in your slideshow. Select 
an individual photo to add visual and transition effects to it.

B Viewing area:  View the photo to which you want to add visual, transition, or pan and zoom 
effects.

C Play button:  Click to play the slideshow on your computer screen.

D Preview button:  Click to preview the slideshow in the iPhoto window.

E Effect pop-up menu:  Choose to convert the selected photo to black and white or sepia.

F Transition pop-up menu:  Choose the transition effect that occurs between the selected photo 
and the photo following it.

G Pan and zoom controls:  Use these controls to set up pan and zoom effects for the selected 
photo. Turn the effect on or off by selecting or deselecting the Ken Burns Effect checkbox. Then, 
click Start to set which part of the photo is showing at the beginning and End to set the end of 
the effect. Use the zoom slider (L) to zoom the photo in or out.

H Adjust button:  Click to change the display duration and transition effect for the selected photo.
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Book View
When you select a book in the Source list, iPhoto displays its pages and provides tools 
to easily create the perfect book for any occasion.

 

I Settings button:  Click to choose visual effects for your entire slideshow.

J Music button:  Click to choose the background music for your slideshow.

K Arrow buttons:  Click to go to the previous or next photo in a slideshow.

L Zoom slider:  Drag to select which part of the photo is displayed during your slideshow.

A Page View button:  Click to display book pages in the photo browser.

B Unplaced Photos button:  Click to display unplaced photos. You can place these photos in your 
book by dragging them to a page.

C Photo browser:  View book pages or your book’s unplaced photos.

D Viewing area:  View the page you selected in the photo browser. To rearrange photos on the 
same page, drag them to a new location on the page. To replace a photo on a page, drag a new 
photo from the photo browser to the photo you want replaced.

E Zoom slider:  Position a selected photo within its book frame by zooming in on only the area 
you want to show.

F View buttons:  Click to show single pages or two-page spreads in the viewing area.

G Themes button:  Click to select a book size and layout design.

H Page Type pop-up menu:  Choose a new page type for the selected page.

I Page Design button:  Choose a new layout for the selected page type.
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Calendar View
When you select a calendar in the Source list, iPhoto displays its pages and provides 
tools to easily create up to 24 months of memories.

 

J Add Pages button:  Click to add a new page to the end of your book.

K Autoflow button:  Click to add all unplaced photos to the book, adding pages as needed.

L Settings button:  Click to choose fonts, text styles, photo captions, and whether to show page 
numbers.

M Play button:  Click to play book pages as a slideshow. 

N Buy Book button:  Click to order professionally printed and bound copies of your book (available 
in some countries only).

O Arrow buttons:  Click to go to the previous or next page.

P Zoom slider:  Drag to zoom in and out of book pages.

A Page View button:  Click to display calendar pages in the photo browser.

B Unplaced Photos button:  Click to display unplaced photos. You can place these photos in your 
calendar by dragging them to a page.

C Photo browser:  View calendar pages or your calendar’s unplaced photos.

D Viewing area:  View the page you selected in the photo browser. To rearrange photos on the 
same page, drag them to a new location on the page. To replace a photo on a page, drag a new 
photo from the photo browser to the photo you want replaced.

E Zoom slider:  Position a selected photo within its frame by zooming in on only the area you 
want to show. 
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Card View
When you select a card in the Source list, iPhoto displays its pages and provides tools 
to create cards for any event or sentiment.

F View buttons:  Click to show single pages or two-page spreads in the viewing area.

G Themes button:  Click to select a calendar design.

H Layout pop-up menu:  Choose a new layout for the selected page.

I Design button:  Choose a new design for the selected page.

J Autoflow button:  Click to add all unplaced photos to the calendar, adding pages as needed.

K Settings button:  Click to choose fonts, text styles, photo captions, and whether to show page 
numbers.

L Buy Calendar button:  Click to order professionally printed copies of your calendar (available in 
some countries only).

M Arrow buttons:  Click to go to the previous or next page.

N Zoom slider:  Drag to zoom in and out of calendar pages.

A Photo browser:  View unplaced photos for your card. You can place these photos in your book 
by dragging them to a page.

B Viewing area:  View the page you selected in the photo browser. To rearrange photos on the 
same page, drag them to a new location on the page. To replace a photo on a page, drag a new 
photo from the photo browser to the photo you want replaced.

C Zoom slider:  Position a selected photo within its frame by zooming in on only the area you 
want to show.
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D Themes button:  Click to select a card size and design.

E Background pop-up menu:  Choose a background for the card.

F Design button:  Choose a new design for the card.

G Settings button:  Click to choose fonts, text styles, photo captions, and whether to show page 
numbers.

H Buy Card button:  Click to order professionally printed copies of your card (available in some 
countries only).

I Zoom slider:  Drag to zoom in and out of card pages.
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